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Chapter 1

VisualArts

1.1 VISUAL ARTS DOCUMENTATIONS

Introduction Future Ehancements

Screen Mode Setup History

Layout Editor Bugs

Screen Setup Demos

Preference Setup Registration Info

Scripts Disclaimer

Object Master Copyright Notice

C Codes Why Another GUI

ARexx Installation

Custom Images

Color Map

Visual Arts V1.1 (c) Copyright 1994 Danny Y. Wong All rights reserved.
Fido: Danny Wong @ 1:134/20

Home 403-274-9348 (6:00pm to 11:59pm MST) Internet: danwong@foul.cuug.ab.ca

1.2 Introduction

Visual Arts Introduction

Visual Arts is an Graphical User Interface designer based on the Gadget
Tools library for Workbench 2.0 and higher. Visual Arts takes a different
approach in creating professional GUIs that will improve your development
time.

Visual Arts has some unique features such as creating primitive graphic
drawing objects such as Circles, Lines and Rectangles with options

of filled and custom patterns; a Menu Manager to manage all menus,

a List Manager to manage lists, and Scripts can be attached to
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any active object or menu items and many other unique features. Version 1.1
now includes the PopUp menus, AREXX interface, custom images, custom images
for buttons and palette picker.

What set Visual Arts apart from other GUI designers is its ease of use

and object oriented approach. Any objects created such as GadTools or
Texts can be manipulated such as sized, change its attributes such color,
font or positioning; everything you need to do is all visually on

screen, no need to dig through multi-level menus or requesters to perform
an operation. Unlimited windows can be opened even with the same layout.
With Visual Arts simple user interface, prototyping and screen designs can
be constructed in minutes with instant C source code and

dynamic link to other applications thru AREXX.

1.3 create gadtools

Creating Gadget Tools General Requster(IFF)

To create a gadget tool select the Object tool type from the tool

palette and draw the outline of the button. Every object requires a name.
Once the object is named select a Gadget Tool from the left or by selecting
the "Edit’ button to edit the default gadget tool.

The positioning of any gadget tools or objects can be done using

the co-ordinates in the middle or by dragging the object in the layout.

To edit any gadget tools simple double click on the object and the
attribute requester will be shown with the gadget tool type selected for
this Gadget Tool. GadTool Requester(IFF)

Majority of the Gadget Tools you can assign a keyboard equivelent. To
assign a keyboard short cut, check the UnderScore box and enter the key
short cut. The key short cut must exist in the Gadget Tool name. For
example if button gadget is created and name "My Button’ and assigned a key
short cut of ’a’, the ’a’ key must be in "My Button’ which in this example
is not. Note: do not use duplicate assignments such assigning the same
key value to two different objects. Uppercase *A’ and lowercase ’a’ are
not the same key value. If your object is assigned an A’ you will need

to press shift-"a’ in order to select or activated the object.

Also each Gadget Tool may have its own font, size and style. If you are
going to distribute your application make sure that your users have the
same type of fonts or simply include the fonts with your distribution.

MX (Radio), Cycle and ListView Gadgets

When these gadgets are created and when setting up their attributes, a
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label name is required for each GadTool except for ListView gadgets this is
optional. The label name is taken from the List Manager and in order

to assign a lable you must first create a list using the List Manager.
IMPORTANT: When creating a large application with many sub-programs, you
must name each object different and thus they must be unique otherwise

the compiler will compliant.

1.4 Screen Mode Setup

Screen Mode Setup Screen Setup (IFF)

When starting up Visual Arts you can select any of the available screen
modes, changes it size or depth. The reason to include all the

available types for your environment is that you may want to design

in lo-re, hi-res, super-hires or a custom screen size. Visual Arts will

handle any types of screen that your system supports under WB2.0+ including
AGA modes.

In start up you can also load a project, Visual Arts will use this project

as its default screen. You can not change the screen type in the design mode.
Any projects loaded will be defaulted to the screen mode selected in start
up.

For example. If you loaded a project that has depth of 2 maximum four
colors, and then opened a new project that has a depth of 3, it will not

use the new projects screen type.

Visual Arts uses Hires 640 x 200 screens therefore when you open a Lores
screen without virtual screen, all requester will be chopped off because of
the size different.

Note: If you set the screens to a virtual screen, it may crash your

system on some of the modes.

1.5 Layout Editor

Layout Editor Editor (IFF)

Objects are created, edited or deleted in layout editor. Objects created
in the layout editor may not represent the final actual representation.
However, Visual Arts produces a close approximation of each object.
Because the actual Intuition GadTools are not used in the layout, it does
not give the true WYSIWYG but the final output is very close.

When creating an object, you are required to enter the objects name,

this name is for identification for non-GadTool objects, and this name
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will be the actual function name for GadTools.

Layout Editor has a Tool Bar (IFF) attached to it and any objects you
create, you must use the tool bar. The tool bar consists of:
Key Short Cuts description of all key short cuts

Arrow to manipulate an object

Text to create a text object

Circle to create an unfilled circle object

Filled Circle to create an filled circle object

Rectangle to create unfilled rectangle object

Filled Rectangle to create unfilled rectangle object

Line to create a line object

DEL to delete selected objects

UND to undelete deleted objects

LIST to create lists

MENU to create menus

GRID to turn on/off grids

WINDOW to customize your window

Justification to justify objects

1.6 Arrow

Layout Editor : Arrow Tool Bar (IFF)

When the Arrow tool is selected, you can select any objects on the layout
by moving the pointer to the object and press the left button mouse. Once
an object is selected, four handles are drawn on each corner of the object.
To size the object move the pointer to any handle and press and hold the
left mouse button and drag the mouse in any direction to size the object.
Once satified with the result, release the mouse button the object is now
deselected.

To move an object, move the pointer to the object and press and hold the
left mouse button then drag the object to the desire position and release.
To edit the objects attributes select the object by double clicking the
object. This will bring up the object attribute requester.

To deselect an selected object move the pointer to a none object and
press the left button mouse.

Moving and Copying Multiple Objects

To select multiple objects hold down the LEFT shift key and start
selecting objects by clicking on them. When done release the shift key.

To move multiple objects, select all the objects, now select an object
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and hold down the left mouse button while the LEFT shift key is still
down.

To copy multiple objects, select the objects and select the Copy edit menu
option. To select all the objects, select the ALL menu item in the Edit

menu. You can move, delete and copy with the ALL option.

1.7 creating text

Layout Editor : Text Tool Bar (IFF)

The text tool lets you create text objects on the layout. To create a

text object, select the A’ object next the the Arrow tool. Once text tool
is selected, move the pointer to the desired position on the layout and
press the left mouse button; this will bring the up the text attribute
requester. The text attribute requester require that you enter the objects
name, the text to be printed on the layout, optional font name, text color,
text background color and text box. The text box draws a box around the

text. To size the box, select the object and size the handle.

1.8 creating circles

Layout Editor : Circles Tool Bar (IFF)

By selecting this tool it will create a filled or unfilled circle on the

layout with optional pattern. To create a circle object, select the either
circle tool and position the pointer on the layout and press and hold the
left mouse button and drag the pointer to size the object to a desire

size. Once satified release the mouse button, this will bring up the

general object attribute requester.

The circle object may have the following attributes set. Object name,
border color, fill color, line width and pattern. The Box Type and Gadget
Tools areas can not be selected. The position box on the middle shows the
actual position of the object on the layout, the object position may be
changed by editing the objects co-oridinates. Selecting the OK button will
accept the object and selecting the CANCEL button will abort the creation

if this is a new object.
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1.9 creating rectangles

Layout Editor : Rectangles Tool Bar (IFF)

By selecting this tool it will create a filled or unfilled rectangle on

the layout with optional pattern. To create a rectangle object, select the
either rectangle tool and position the pointer on the layout and press and
hold the left mouse button and drag the pointer to size the object to a
desire size. Once satified release the mouse button, this will bring up

the general object attribute requester.

The rectangle object may have the following attributes set. Object name,
border color, fill color, line width and pattern. The Box Type and Gadget
Tools areas can not be selected. The position box on the middle shows the
actual position of the object on the layout, the object position may be
changed by editing the objects co-oridinates. Selecting the OK button will
accept the object and selecting the CANCEL button will abort the creation

if this is a new object.

1.10 creating line

Layout Editor : Line Tool Bar (IFF)

By selecting this tool it will create a line object on the layout. To

create a line object, select the line tool and position the pointer on the
layout and press and hold the left mouse button and drag the pointer to
size the object to a desire size. Once satified release the mouse button,

this will bring up the general object attribute requester.

The line object may have the following attributes set. Object name,
border color and line width. The Box Type and Gadget Tools areas can not
be selected. The position box on the middle shows the actual position of
the object on the layout, the object position may be changed by editing the
objects co-oridinates. Selecting the OK button will accept the object and
selecting the CANCEL button will abort the creation if this is a new
object.

1.11 deleting an object

Layout Editor : Deleting an Object Tool Bar (IFF)

Selecting this tool will delete the selected object. To delete an object
move the pointer to the object to be deleted and select it by press the

left button mouse. Once the object is selected, select the "DEL’ tool from
the tool palette. This will delete the object from the layout. You will

not be warn when deleting an object. To undelete the deleted object select
the "UNO’ tool from the tool palette. Keyboard short cut is

the ’DEL’ key next to Help.
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1.12 undelete an object

Layout Editor : Undelete an Object Tool Bar (IFF)
Selecting this tool will undelete the deleted object. Undelete will only
work if no other operation has been done since the object is deleted such

as selecting another object or tool. To undelete an delete object select

the "UDOQO’ tool.

1.13 create lists

Layout Editor : List Manager Tool Bar (IFF)

One of the unique feature in Visual Arts is the List Manager and the
Menu Manager. List (IFF)The List Manager enables you to create
unlimited number of lists and list items.

To create a list select the menu tool below the "DEL’ tool this

will bring up the list manager window. The left side of window shows all
the list name that has been created for this project, and on right side it
shows the list items that associated with the each list name.

To enter a new list name, type in the list name and press the TAB key or
by selecting the "New’ button this will erase the current input buffer.
Once a new list name has been entered you can now add new items to the list
by typing in the item on the right labeled ’List Items’.

To delete an existing list name, select the list name from the 'List Names’
listview and select the *Del’ button. To delete a list item, select the

item from the "List Items’ listview and select the *Delete’ button on the
List Items side. To add new items to an existing list name, simply select
the list name and starting entering the new list items.

The List Manager includes sorting in Adscending and Descending features.
To sort the selected List to Adscending select *Sort A’ and to sort the
List to Descending select *Sort D’. If you preferr to custom pick the
ordering of the list, you can select the *Pick’ button. This will put you
into the Pick List requester.

Custom Ordering Pick (IFF)

In the Pick List requester, the left side contains all the list items,

and on the right is the ordering. To reorder the list items, simply

select an item from the left and select the *>>" button, this will move

the item to the right. To move the item back to the item list, simply
select the item from the right and select the <<’ button. When all the
items have been reordered, the OK button will be enabled. Select the OK
button to accept the ordering or CANCEL to revert any changes.

Note: All the lists and list routines will be generated during source

code output.
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1.14 create menus

Layout Editor : Menu Manager Tool Bar (IFF)

One of the unique feature in Visual Arts is the Menu Manager and the

List Manager. Menu Manager (IFF) The Menu Manager enables you

to create unlimited number of menu bars. To create a new menu bar select
the menu tool next to the List tool this will bring up the Menu Manager.
The Menu Manager manages each menu bar separately. To create a new menu
bar, select the "New’ button, to delete a menu bar first select an existing
menu bar from the menus listview and select the ’Delete’ button, to edit

an menu bar first select an existing menu bar from the menus listview and
select the "Edit’ button, and to exit Menu Manager select the ’Cancle’
button or the CloseBox’.

Creating/Editing Menu Bar Menu Bar (IFF)

When editing or creating a new menu bar Menu Manager opens another
window. The menu window is logically placed so that the Menu Title are
on the left, Menu Item in the middle and Sub Items on the right. Each
listview contains the ’New’, Bar’ (except for Menu Title), and *Delete’
buttons and an text entry gadgets. To add a new menu select '"New’ from the
’Menu Name’ listview and enter the new menu name and press RETURN. This
will bring you to the Menu Item listview area. To add a new menu item,
enter the new menu item name and press RETURN, this will bring you to the
Sub Item listview. To add a new sub item enter the new sub item name and
press RETURN. To place a separator bar between Menu Items or Sub Items
select the *Bar’ button.

Each Menu Item and/or Sub Item may contain a short cut key equivlent or
check mark. To assign a Menu Item or Sub item a short cut, select the Menu
Item or Sub Item name from the listview and select the Keyboard, Checkit,
Checked, Disabled or MenuToggle flags. Note while assigning a short cut
key, you must press enter after assign the key.

To change the default Topaz 8 font for the window, select the *Font’

button and select a font. Note that it only displays the font name when

you select it and doesn’t display the size and flags.

To test the menu in real time, double click the right mouse and hold on

to the right mouse. This will let you preview the current menu bar.

Scripts for Menu Items

Custom codes can be inserted in for each menu item. Select the menu item
and click on the Script button, this will open the editor. Make sure the

editor path is setup in the Preference menu.
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1.15 creating window

Layout Editor : Window Setup Tool Bar (IFF)

Window Type (IFF)Selecting this option will open the window setup window. Here
you specify what type of window you want, window flags, window IDCMPs and
window attributes such as window co-ordinates and window title. To select

a window type click in the window showing. The default window has a
CloseGadget and DepthGadget. Currently there are only 12 types will you

can choose from. To change the window flags select the *Flag’ button.

This will let you select custom flags for you window.

To change the IDCMP flags, select the 'IDCMP’ flag this will let you

select custom IDCMP flags. Note that you must select the IDCMP_VANILLAKEY
check box if you want short key cut codes generated for you.

To change the window attributes select the *Attr’ button. WindAttr (IFF)

The left, top, width and height values are taken from the physical size of

the layout in design mode. To change the size of the window you can change

it here or by sizing and moving the layout in design mode. Also an

important point to note is that the right and bottom scroll widths and

heights is not included in calculating the size of the window. To get the

actual size of the window, size the window right and bottom to the last

printable line on the layout.

**Note** Visual Arts presets the window flags and window IDCMP according to
the window type you selected and the type of objects your have created in

the layout.

AppWindow Option WindAttr (IFF)

To make the window an AppWindow, select the AppWindow option. This will
enable the window to receive any icons dragged into the window, and at the
same time retain its original form.

Multi-Processing Windows WindAttr (IFF)

One of the powerful feature in Visual Arts is the ability to generate

codes for multi-processing windows which are independent of other windows
when opened. You are no longer stuck performing operations on one window,
now with Visual Arts you can enter the world of multi-processing windows.

To set up multi-processing windows, select the Multi-Process check box.

This will enable your window to do multi-process, is that simple! When

you generate the codes, the program will be set up for multi-processing for

that window.

In order to make other windows multi-process besides the main program,

you will need to make every window a multi-process by selecting the
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"Multi-Process’ option in the Attr setup. Once this is done, you will also

need to give it the Main program project name. This is done when generating

the actual codes. The entry name can be any sub-program name but the main

project name must be the same as the entry name eg: void main(void).
Code Pref

You must select the ALL option for the Main Program which it creates all

the neccessary routines for doing multi-processing. For sub-programs do not

select the Screen Routines option because its created in the main. You
will also need to change the Entry Name for sub programs because you can

only have one main(...) function. Entry Name can be any name. You will

also need to enter the Main Project name which can found in the main project

in the Window setup’s WindAttr (Project Name). WindAttr (IFF)

In order for the main program to link to your sub programs, you will need
to edit the your main program and add the following line at the beginning

of the main program, this is the prototype function name.

extern void entry_name(argl, arg2 ... argn)

where

entry_name is the name of the sub program entry point.

argl..argn is the arguments

for example:

extern void SubPrg(void);

extern int OpenDoc(char *filename);

now add the second line just before the main program opens its window in
the main program.

for example:

OpenDoc("mydoc.data"); //open the doc

if ({(OpenMain("main window)) //open main program window

1.16 creating grid

Layout Editor : Set Grid On/Off Tool Bar (IFF)
Grids can be turned on or off anytime in the design mode. This gives
the designer precession when placing objects together. You can set the

X and Y grid size in the Project menu under Preference menu item.
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1.17 Object Justifications

Object Justifications Tool Bar (IFF)

Selected objects can be justified in any of the four orientations. To
justify objects, select the objects to be justified and select the justification
button on the tool palette. The first selected object is the anchor object.
All objects will be justified according to that object. Currently line
objects can not be justified, selected line objects will not do anything if

justified with grouped objects.

1.18 Layout Editor Short Cuts

In order to simplified getting around and manipulating objects in the
layout editor, there are a number of short cuts which will make your editing
much more easier.

Action Descriptions

Alt - Double click on an object -hold the Alt key down and double
click the left mouse to go directly

to the script editor.

Control - Double Click -hold the control key while double click
will open the general requester.

MOVING AN OBJECT

Up Arrow -move the selected object one pixel up.

Down Arrow -move the selected object one pixel down.

Left Arrow -move the selected object one pixel left.

Right Arrow -move the selected object one pixel right.

Alt Up Arrow -move the selected object 5 pixels up.

Alt Down Arrow -move the selected object 5 pixels down.

Alt Left Arrow -move the selected object 5 pixels left.

Alt Right Arrow -move the selected object 5 pixels right.

SIZE AN OBJECT

Alt Shift Up Arrow -size the selected object 1 pixel less.

Alt Shift Down Arrow -size the selected object 1 pixel larger.

Alt Shift Left Arrow -size the selected object 1 pixel more

in width.

Alt Shift Right Arrow -size the selected object 1 pixel less

in width.

BORDER AN OBJECT

Alt 1 -draw a STANDARD border around the rectangle
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object such rectangle and GadTools.

Alt 2 -draw a BEVEL border around the rectangle
object.

Alt 3 -draw a RECESSED border around the rectangle
object.

DEL -delete all the selected objects.

1.19 Screen Setup

Screen Setup

To setup your own custom or public screen select Screen from the menu
name 'Design’. In screen setup you can choose the public or custom
screen, the screen type and the font for the screen. If you opened an
screen with depth of 2 or greater Visual Arts does not know of this, and
you will need to select the Custom Screen otherwise Visual Arts will

assummed its a Workbench screen.

1.20 Visual Arts Preference Setting

Preference (IFF)

The Preference menu option lets you set the path name for the scripts and
the editor to be used for editing scripts etc. You must set these setttings

if you’re going to use the scripting feature. Path names must be a full
path name eg: dhl:VisualArts/Objects and the editor program does not have
to contain a path name as long as the system can find the editor eg: se
will work perferctly fine for SAS/C editor.

You can also set the X and Y grid size for the layout grids. The

interval saving feature is default to save every 15 minutes. If the

history is selected, Visual Arts will make backup copies of the project.
The way the history works is, suppose your project name is Inventory.
Visual Arts will save the next file to be Inventory1, Inventory2 and so on.
But the next time you edit Inventory3 for example Visual Arts will not
save the next file to be Inventory4 instead Inventory41. Visual Arts

always starts with one and keeps incrementing.
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1.21 Object Master

There are times when you want to save an object for use in other projects
and that’s where Object Master comes in. Any GadTools can be saved as an
Visual Arts object or as an Visual Arts Script. The difference between the
two is that a Script is codes and can not be loaded into the layout editor
but an Object can be loaded into the layout editor.

To save the object select the object to be saved in the layout editor and
select one of the menu item option from the Object menu choice. A file
requester will be displayed for you to enter a name for the object to be
saved. Objects should be saved in one central location since objects can
be shared between different projects. Note only the first selected object
will be saved, Object Master does not support multiple save objects.

To load an object or script into the current project, select ’Object

Master’ from the Object menu. Object Master (IFF)

To edit or add a new script select the > Add/Edit Script’ from the Object
menu.

When you have a piece of code and wish to share it between different
projects, Visual Arts will convert the script into a Visual Arts script
object for sharing. Select *Script -> Object’ to convert the script.

When you add a script object to your project, you can view all the scripts
by selecting the *Object List’ in the Design menu. This will list all the
scripts you have included for this projects. Now you can call these

functions in your other functions. Object List(IFF)

1.22 Scripting

The Scripting (custom code) in Visual Arts lets you insert custom codes
into any active object such as GadTools and menu items. Script (IFF)
To enter a script for an object, hold Control and double click on the
object to open the general requester, select ’Edit” on GadTools Type and
and select the ’Script’ button; key short cut is Alt - double click on the
object will bring you directly into the script editor. Short Cuts

If the script has not been attached to the object, Visual Arts will

create a stub function:

for all GadTools - Obj meaning GadTools object

int mybuttonObj(struct VAobject VAODbject)

{

return(1);
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}

for Menu items - MenuObj meaning Menu object

int QuitMenuObj(struct VAobject VAODbject)

{

return(1);

}

VAobiject structure is defined as:

struct VAobject

{

struct Window *va_Window; //current window

struct Gadget *va_Gadget; //gadget that the user have selected
struct IntuiMessage *va_IntuiMsg; //IntuiMessage

APTR va_UserData; //user data for functions etc..

ULONG va_Flags; //user flags READ/WRITE

}

Visual Arts will fill VAODbject structure for GadTools objects as follows:
VAODbject.va_Window = project window

VAObject.va_Gadget = current gadget selected
VAObject.va_IntuiMsg = msg - Intuition message
VAObject.va_UserData = 0 (user definable)

VAObject.va_Flags = 0 (user definable)

Visual Arts will fill VAODbject structure for Menu objects as follows:
VAObject.va_Window = project window

VAObject.va_Gadget = NULL

VAObject.va_IntuiMsg = msg - Intuition message
VAObject.va_UserData = 0 (user definable)

VAObject.va_Flags = 0 (user definable)

for menu item functions DO NOT read or write the VAObject.va_Gadget
field because it contains NULL values.

example function that use VAobject structure

int LoadObj(struct VAobject VAObject) //button object

{

char filename[80];

int rc;

/lopen file requester and get a file

rc = GetFontName(FALSE, VAObject.va_Window, "Load File", "ram:",
"" (char *)&filename);

if (rc) //got a filename so print it using a TEXT GadTool

{
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SetGadgetAttrs(TestGadgets[ID_filename], VAObject.va_Window,

NULL, GTTX_Text, filename, TAG_END);

LoadFile(filename);

/lmodify VAObject UserData to include a function for displaying

//the text file

VAObject.va_UserData=(APTR)DisplayTextFile;
DisplayTxtObj(VAObject); //call other objects

}

return(1);

}

When an Intuition event ocurrs such as clicking on any GadTools or
selecting a menu item, Visual Arts will fill this structure and pass it to

the script for this object. In the function, you can programmatically

handle the event. In turn, you could pass VAObject structure to another
object script and have it execute its function.

VAObject structure can be READ or WRITE by your program with caution.
All scripts must contain atleast one function, and also must return a

int value. You can start to insert the codes inside the function. A script

may contain more than one function, declare variables or whatever a program
maybe contain, think of scripts as an external program.

If your choice of editor supports opening of multiple files, you should

see the script on the top (SAS/C SE) and on the bottom it shows the actual
codes of the main program. This file is for references only do not edit,

its only for you to reference variables. The second part of the file

contains the header include files, this is where all the stub functions for
GadTools and menu items go. As you will see, all the variables are declared
extern so that in your script you don’t need to redeclare the variables.
Visual Arts will generate three files when you output to ¢ source codes,

the first as mentioned is the main program, and the second one is the
include header files containing all the stub functions and the third file
contains all the scripts include for the project.

There is no limitations in scripts, because scripts are functions or

extern program when Visual Arts merge the scripts with the main program.
When you are done editing the script, save the script and DO NOT rename
the script. You will also need to quit the reference file too since you

are editing two files. The reference file will not be saved. Use the

editor’s option to save and quit.

IMPORTANT: Visual Arts uses the objects name as a reference to the actual

script stored on the defined path, if the object name is modified, Visual
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Arts will rename the script to the new name but the script is left
unmodified.

Main Script

The *main() script’ menu item option under menu "Design’ lets you add
any global variables to your project. This is useful if you are using

Visual Arts for complete development environment. Variables declared in
this file can be any valid syntax such as declaring arrays, integers, etc..
This file will be appended to the main program, you can reference this
file anytime by editing the script.

Script Initialization

Another feature of Visual Arts is the ability to initialize your declared
variables in the Main script. This is very useful if you need to assign

a value to a variable but can’t be done during declaring but only at
runtime. This script works in conjuction with the Main script. For example,
if you have defined the following in the main script.

main script:

char filename[40];

init script:

strepy(filename, "my.datafile");

1.23 Generation C Source Codes

Design Mode : C Source Code Code Pref

Visual Arts currently only supports for C source codes. Future version

may other languages. Generated source codes can be compiled without adding

a single line of code, of course you wouldn’t be able to doing anything
except for playing with GadTools.

Visual Arts lets the programmer choose what part of the codes to
generate. There are times when you only need to generate part of the codes
such as modifying some gadgets and you don’t need to generate all of the
codes just because you have modified the gadgets. You can then replace
the older gadget definitions with the new codes. Code Pref (IFF)

The preference settings are:

1. Screen. This will generate codes opening and closing public or custom
screens.

2. Function. This will generate function codes that’s internal to

Visual Arts such as drawing primitive shapes, list routines etc. You
probably would only generate this once and reuse the codes.

3. Window. This will generate codes for opening and closing window. It




VisualArts

17 /25

will also generate all window varaibes such as its co-ordinates.

4. Handler. This will generate codes for the IDCMP handler to events.

5. Intuition. This will generate codes for all GadTools, primitive
drawings, texts, menus, fonts and lists.

6. All. This will generate a complete appllication.

There is also an option to name the entry function. Its default is

“int main(int argv, char *argc[])’. By changing the entry function name,
you can create a complete sub program which the main can call. The entry
name can not contain any spaces and it must be valid in syntax.

For example:

My function --> incorrect

void My_function(void)

or

int Myfunction(short X, short y) --> correct

the function can also return values and accept arguments such as above.
Note the entry function name does not contain a semi-colon.

Visual Arts generates four seprate files. The first file contains the

’.c” extension and second file contains the *.h’ extension, and the third
file contains ’.script’ all the scripts and the fourth file contains all

the images and color map data. For example:

Calcuator.c -the main file

Calcuator.h -function file

Calcuator.scripts -any included scripts (may not contain any codes)
Calcuator.images -images and colormaps (may not contain any codes)
The main file contains all the intuition codes such as gadget, menu, text,
and other definitions, window and screen opening and closing and the event
handler. The header file contains all the functions that supports the main
program such drawing primitive shapes, text, list creation gadget and menu
functions when the user selects a gadget or a menu item.

Things you should know

1. Each Gadget Tools contains a function. Each time the user clicks on a
gadget tool it calls the function name. Do your coding in the function.
The function name usually starts with the object name that you defined

in the layout editor. eg: mybuttonObj

The menu and gadget tools functions are in the header file. DO NOT
have objects with the same name, this is thru out your projects.

2. Menus also has the same characteristics as gadget tools in 1. Each time
a menu item or sub item is selected, the function will get executed.

3. Multiple font names with the same size but different styles are
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supported in this release.

Built-in Function (those functions are now in the library in V1.1)

1. DrawBox - this function draws a box in the specified window with the
specified dimension, color and pattern type.

void DrawBox(struct Window *Wind, int Left, int Top, int Wid,

int Hi, UBYTE APen, short Pattern );

APen - any valid pen color for this screen

Pattern - line pattern number support by Visual Arts (0-5)

2. DrawFBox - this function draws a filled box in the specified window with
the specified dimension, color, pattern type, outline and

filled.

void DrawFBox(struct Window *Wind, int Left, int Top, int Wid, int Hi,
UBYTE APen, short Pattern, UBYTE Outline, short Fill );

APen - any valid pen color for this screen

Pattern - line pattern number support by Visual Arts (0-5)

Outline - any valid pen color for this screen

Fill - filled pattern number support by Visual Arts (0-47)

3. SetRPortFill - This function set the rast port to a specified fill type.
void SetRPortFill(struct Window *Wind, short Type);

Type - filled pattern number support by Visual Arts (0-47)

4. ButtonSelected - This function emulates the user as if the button or
cylce button as been selected. This only hilights the gadget but it

won’t cycle to the next item if the gadget selected was a Cycle.

void ButtonSelected(struct Window *wind, struct Gadget *gad);

wind - current open window

gad - gadget to select Button or Cycle gadgets

5. GetNewList - This function allocated memory for a new list and returns
it address. Returns NULL if can not allocate.

struct List *GetNewList(void)

Example: mylist = GetNewList();

6. AddNewNode - This function adds a new name node to specified list.
Returns 1 if no memory and O for name added.

int AddNewNode(struct List *list, char name[255]);

Example: rc = AddNewNode(mylist, "Amiga Computers");

7. DeleteNode - This function deletes a name node from a specified list.
Returns 1 if name node not found and O for deleted.

int DeleteNode(struct List *list, char name[255])

Example: rc = DeleteNode(mylist, "Ibm");

8. FindNodeName - This function search a list for a specific name. Returns
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NULL if not found.

struct NameNode *FindNodeName(struct List *list, char name[255]);
Example:

struct NameNode *mynode;

mynode = FindNodeName(mylist, "Amiga");

if (Imynode)

printf("can’t find name\n");

9. FreeList - This function frees a all the name nodes created using
AddNewNode for a specified list name.

void FreeList(struct List *list);

Example: FreeList(mylist);

IMPORTANT NOTE:

Since Visual Arts lets you output part of the project, it is important to

know that each project shares the same built-in routines as described above.

When generating only parts of the project, there maybe duplicate routines

generated such in the project that generates ALL option. When linking your

objects you may encounter duplicate functions. To correct this problem,
change or delete the duplicate codes in all your projects except your main

project. eg: suppose that your main project generates ALL and your other

projects only needs to generate the Window and Intuition parts. And suppose

it does some primitive drawings such as a Circle. Visual Arts may generate

the drawing functions that your main program already have.

1.24 General Attribute Requester

General Attribute Requester General Requester (IFF)

The Genenal Object Attribute Requester lets you customize each object
such as colors, line width, line color etc. Each object’s attribute is
different from others. For example, object Rectangle is different from
object Circle in that the object Rectangle can be a Bevel or Recessed box.
The Attribute Requester is divided into four parts. The top part deals
with the objects color and pattern, the middle deals with the positioning
of the object on the layout, the bottom deals with only Rectangle objects,
a Rectangle object can be any of the three types. The right deals with

GadTools only.
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1.25 Future Ehancements

Future Ehancements

1. Requesters - generate custom or easy requesters.

2. Structure builder for designing your data models. (Designing)
3. AmigaGuide support.

4. Browser support (Help Files)

5. C++ libraries

6. Font sensitive.

1.26 Demos

Demos

There are some demos program included in the archive. There have not
been modified at all except for the AppWinArexxScript which I have added
some custom codes to it. The demos are no mean of complete, there just

to show some of features in Visual Arts. You can load and generate the

source codes your self.

1.27 Bugs! Bugs! and more Bugs! This really Bugs Me!

Bugs! Bugs! and more Bugs! This really Bugs Me!

An application is not complete without any bugs right? :-) There are

a few known bugs if you have Enforcer (Great Tool) installed.

1. Menu Manager - When deleting a Menu Title, Visual Arts doesn’t seem to
free up or try to free other allocated memory. This only happens once

a while and it doesn’t GURU or crash your system. I'm trying very

hard to find this bug but this is a very smart bug indeed.

2. The very first thing you create is a text object in the design mode,
sometimes it doesn’t get stored and thus when you try to manipulate it

the object wouldn’t get selected. Can’t really explain, it shouldn’t

happen.

3. This bug is related to the bug number one. When quitting Visual Arts,

the allocated memory of the Menu Manager some how got corrupted and
when freeing it, it gives you hits in Enforcer.

4. When Closing a window or quitting and you selected CANCEL, it sometimes
won’t quit! Go figure. The work around when you can’t quit is to

resize or drag a window and then it will quit. What stupid coding! :-(

comment: This should be fixed in V0.40.
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5. There seems to be a problem when making lo-res screens larger than

the default 320x200 or interlaced with auto-scrolling. If you set

these settings other than the defaults it may crash!!! Looking into

the problem. Version: V0.40

6. When creating a image object, the actual size representation on the layout
doesn’t seem to draw correctly. You will need to double click on the

object and select OK again to actually update itself. Version: 1.1

A great deal of time have spent on killing these nasty bugs and there is

no gurantee that more bugs won’t resurface. If we programmers can write
error-free programs, we would be out of a job. So please keep that in

mind and support other authors who make THE Amiga as their CHOICE.

1.28 History

Version Released Notes

V 0.10 Feb 2/94 -first initial release (very buggy indeed)
V 0.20 Feb 14/94 -alot of new features added and bug fixes
V 0.30 Apr 01/94 -No April 1 Joke Here :-) lots of fixes
-Added ASL font

-Fixed AppWindow event handler

V 0.40 Apr 03/94 -Added scripts for all active objects and
menu items, and sub items.

-fixed the duplicate objects for text

objects.

-added key short cuts for manipulating

objects.

-added object bordering for GadTools

V 0.41 Apr 17/94 -reworked main preference

-minor fixes on code generation

-added Object Master

May 1/94 -reorganized the doc

V 1.0 May 9, 1994 -offical general release

V 1.01 May 15/94 -modified so that you can change between
text and numeric display GadTools

-modified so that the GadTools requster

shows up instead the General requster

V 1.02 May 20/94 -Added PopUpMenuClass as a standard
V 1.03 May 25/94 -Added AREXX
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-made most the functions into a library

V 1.04 May 27/94 -Added an include file.

V 1.05 June 1/94 -pre 1.1 offical release

V 1.06 June 10/94 -added custom button images

June 15/94 -added images

-fixed the save error during startup

V 1.07 June 23/94 -added get color map from any IFF pic file.
-added color palette

-reworked and add more patterns

V 1.08 July 1/94 -removed recttype when creating a non
rectangle object.

-added automatic object ID

V 1.1 July 5/94 -Offical release

1.29 User Registeration

Visual Arts is Shareware meaning that you have the rights to use Visual
Arts in a limited time of two weeks. After this date, you must register
Visual Arts if you continue to use it. Registeration fees are as followings:
non-commerical use $30.00 US per copy

commerical use $40.00 US per copy

outside of North American please add $5.00 US per copy

When you become a registered user, you will receive the full version of
Visual Arts with bug fixes and enhancements and crippled codes removed.
if ordering by cheque or money order please make payable to: Danny Y. Wong
and mail registration form to:

Danny Y. Wong

131 64 Ave NW

Calgary, Alberta

T2K OL9 CANADA

Thank you for supporting shareware authors.

Bug Fixes, Comments and Contact:

Home 403-274-9348 (6:00pm to 11:59pm MST)

Fido: Danny Wong @ 1:134/20

Danny Wong@1:134/180

Internet: danwong@foul.cuug.ab.ca
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1.30 Disclaimer

Disclaimer: The author makes no warranties, either expressed or implied.
This program is provided on an "as is" basis and the author will not be
liable for any damages caused or alleged to be caused directly by using

this program. Use at your own risk.

1.31 Copyright Notice

Visual Arts is copyrighted 1994 by Danny Y. Wong. You as the user DO NOT
have rights to modified and/or change Visual Arts in any form without
written permission from the author. Visual Arts can not be sold or included

in any disk or electric base distribution without permission from the

author. Illegal duplication is prohibited.

I (DANNY Y. WONG) HEREIN GIVE FULL PERMISSION AND THE RIGHTS TO YOU TO
DISTRIBUTE THE DEMO VERSION OF VISUAL ARTS AS LONG AS THE ARCHIVE REMAIN

UNCHANGED. --------memem-

1.32 Arexx Setup

Arexx Setup(IFF)

Arexx is now part of Visual Arts. Any program created in Visual Arts can
now have its own Arexx port for other programs to access. When setting up
Arexx you first must enter the Arexx port name. This is the most important
step, if Arexx port name is not defined Arexx will not be included in

the source output. Once you have entered the port name, the rest is very

easy. To add a Arexx command simply enter the Arexx command in the entry
field and press return. Note that Arexx commands are case senesitve. To
rename the command, simply click on the name to be changed and type over it
and press return when done. To delete a command, select the name and click
on the delete button. Select OK when done.

As with all active objects, Visual Arts lets you attach or insert your

own custom codes to each Arexx command. When other applications sends a
Arexx command to your application the scripts for this command is automatically

get executed.
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1.33 Custom Images

Visual Arts allow any IFF brush to be loaded although the layout editor
doesn’t show the actual image, it only draws the size of the image. Images
can not be sized in the layout editor. Simply put, you can’t change any

its attributes except images. One important note that if you load a

different depth size brush into the current depth screen the image would
have different colors in the compiled application.

Custom Image: Button

Custom Button (IFF)

Visual Arts allow you to use the regualar standard Intuition boolean

gadget. Boolean gadgets can have its own custom primary and secondary
image or one or no image at all. But Visual Arts won’t draw the border

if the boolean gadget has no images. Visual Arts only recongize IFF brushes
they can be any depth as long as your project can handle the brush depth.
Multiple brushes can be used and Visual Arts only generate one instance of
the same brush when outputing to source. If the brushes to be loaded are

in a different directory but with the same name, Visual Arts treats it as

the same.

Important: Due to a bug, the initial display of the brush doesn’t show the
actual size of the image, you will need to double click on the custom

button image and select OK again to refresh the object.

1.34 Setting a Color Map

Color Map(IFF)

A totally different color map can be selected from any IFF picture file

as long as it has a color map and use it in Visual Arts. If the color map
has more or less than the current color map colors, Visual Arts only loads
the maximum colors allow for the current screen mode. Note that Visual
Arts picks its own random color palette if the project screen has more

than 4 colors.

1.35 Why Another GUI Designer?

Why another GUI designer since there are some many already on the market?
And how good is Visual Arts?
Simply put: There are NO PD/Shareware GUI designer in the Amiga market

that is simple to use and yet powerful enough for professional use. We’ve
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seem many GUI designer lack simplicity in term of use and not enough
features to build professional looking interfaces.

Visual Arts was designed to be simple and yet powerful. It was bulid
from the start to be user friendly and object oriented. There are features
in Visual Arts which aren’t found in any GUI designer.

I’m a lazy user and I'm a creative programmer. I want to do as minimal
work as possible to get the task done and don’t care how its done as long
as the task is satisfying with quality.

When is the last time you’ve evaulated a GUI designer? How’s the user
interface? Was it easy to use? Powerful features? Keep these questions

in mind when you evaulate Visual Arts and compare.

1.36 Visual Arts Installation

Visual Arts requires that you install the following libraries in your
lib: directory and the two include files in the include: directory.
copy to the lib: directory: copy #?.1ib lib:

1. VisualArts.lib

2. PopUpMenu.lib

copy to the include: directory: copy #?.h include:

1. VisualArts.h

2. PopUpMenu.h

In your SASCOPT add the two libraries to the library listview.
Note: you must link with the two libraries. You are only required to

link with the PopUpMenu if you are using the PopupMenu.
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